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1  General 

 
Congratulations!  A camera in the Fastec HiSpec high-speed camera series is 
an excellent choice, because HiSpec’s are extremely versatile, advanced and 
self contained digital camera systems. 
 
This manual provides information about the features and operating modes of 
HiSpec cameras. 
 

1.1 Essentials of HiSpec 

 
With HiSpec cameras, high-speed processes and events can be continuously 
recorded and stored at up to more than 100,000 images per second and can 
be displayed and analyzed in detail immediately after the end of a sequence. 
The images are always initially stored in the internal frame memory of the 
camera.  HiSpec cameras must be connected to a host PC via fast Ethernet 
for camera set-up, downloading and image playback. 
 

1.2 Certifications 

 
1.2.1 For customers in the U.S.A. 

This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to Part 15 of the FCC Rules.  These limits are 
designed to provide reasonable protection against harmful interference when 
the equipment is operated in a commercial environment.  This equipment ge-
nerates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause harmful inter-
ference to radio communications.  Operation of this equipment in a residential 
area is likely to cause harmful interference in which case the user will be re-
quired to correct the interference at his own expense.  You are cautioned that 
any changes or modifications not expressly approved in this manual could 
void your authority to operate this equipment.  The shielded interface cable 
recommended in this manual must be used with this equipment in order to 
comply with the limits for a computing device pursuant to Subpart J of Part 15 
of FCC Rules. 
 
 
 
 
 
 
 



 
 

 
HiSpec Operator's Manual Version 1.11.9.docx  Page 7 of 72 

1.2.2 For customers in Canada 

This apparatus complies with the Class A limits for radio noise emissions set 
out in Radio Interference Regulations. 
 
1.2.3 Pour utilisateurs au Canada 

Cet appareil est conforme aux normes Classe  A pour bruits radioélectriques, 
spécifiées dans le Règlement sur le brouillage radioélectrique. 
 
1.2.4 Life Support Applications 

These products are not designed for use in life support appliances, devices, or 
systems where malfunction of these products can reasonably be expected to 
result in personal injury.  Fastec Imaging customers using or selling these 
products for use in such applications do so at their own risk and agree to fully 
indemnify Fastec Imaging for any damages resulting from such improper use 
or sale. 
 

1.3 Declaration of conformity  

 
Manufacturer:  For Fastec Imaging by Mikrotron GmbH 
Address:   Landshuterstr. 20-22 
    85716 Unterschleissheim 
    Germany 
 

Product: High Speed Cameras – HiSpec Series 
 
The dedicated products conform to the requirements of the Council Directives 
2004/108/EG for the approximation of the laws of the Member States relating 
to electromagnetic consistency.  The following standards were consulted for 
conformity testing with regard to electromagnetic consistency. 
 

EC Régulation Description 

  
EN 61000-6-3 Electromagnetic compatibility  
EN 61000-6-1 Immunity 

 
Unterschleissheim, August 1th 2008 
 
Mikrotron GmbH 
Bernhard Mindermann 
Managing Director, Mikrotron GmbH 
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1.4 Warranty Note 

Do not open the body of the camera.  The warranty becomes void if the cam-
era body is opened. 

1.5 Remarks, Warnings 

This document contains important remarks and warnings.  See the corres-
ponding symbols: 
 
 

� 
 

Important remark 

 
 

 
 

 ���� 

 

Attention, Warning 
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1.6 Backside view of HiSpec 1 and HiSpec 4 cameras 

 
1.6.1 The rear of the camera 

The identification type plate is to be found at the rear of the camera.  It con-
tains the serial number and the MAC-address for identifying the device in a 
network.  
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1.6.1.1 Connectors 

There are 2 connectors and 1 LED mounted on the rear of the Camera.  The 
pin assignments of these connectors are described in chapter 8.2 Connector 
assignments. 
 

 
  
 
  
 
1.6.1.2 LED’s 

The color LED of HiSpec the actual operating condition is indicated.  Three 
colors are possible, (and off-state): 
 
RED 
GREEN  
ORANGE 
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1.6.1.2.1 LED:  internal camera state 

 

 
 
Color LED-state Camera state 

RED constant Boot procedure failure. Switch off the camera and 
try again. 

GREEN constant Ready for the first recording after power up. 
ORANGE blinking Circular recording in progress, waiting for stop. 
ORANGE steady Circular recording stopped. Wait for next start 

signal. 
 
1.6.2 The front of the camera 

The C-mount, (optional „F-Mount“), for the lens is located at the front of the 
camera. 
 

1.7 Scope of delivery 

 
The following components are included as part of the delivery: 
 

- 1 ea. HiSpec camera, version as ordered, see selection below 
- 1 ea. 110-220V power supply 
- 1 ea. USB thumb drive with HiSpec Director 1 software 
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- 1 connector for signal Input  
 

1.8 Power supply 
 
Use an external power supply for external power operation.  
 

���� 

Only voltages in the range from 10.5 to 30 Volts @ 7.5W are 
permitted.  Higher input voltages may seriously damage the 
camera.  Damage of this type is not covered by our warranty. 

 
 

1.9 HiSpec Models: 
 

 
Model  

 
Color 
/B&W 

Standard 
Record 
time  

 
Max. 
Resolution 

Max. 
frame-rate 
[fps] 

 
Lens 
Mount 

      
HiSpec 1  Both 

 
3.2 1280x1024 112,183 C or F 

HiSpec 2 Both 
 

6.5 1280x1024 112,183 C or F 

      
HiSpec 3 Both 

 
3.0 1280x1024 83,500 C C or F 

      
HiSpec 4 Both 

 
1.4 1696 x 1710 298,851 C or F 

HiSpec 5 Both 
 

2.8 
 

1696 x 1710 298,851 C or F 
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2 Operating Modes 

 

2.1 Ready-to-operate 
 
By means of the HiSpec software, (control program), the camera can be set 
up for recording in different operating modes.  
 
If the camera is disconnected from the PC, reconnect it and press the recon-

nect button in order to establish the GigaBit Ethernet link. 
 

 

� 

It is very important to press the reconnect button after the camera is 
reconnected with your system.  If this button is not pressed after re-
connection the chronology of a meanwhile recorded sequence may be 
lost! 
 
The same applies to a completed recording session that has been 
started with the camera’s trigger switch. 

 
HiSpec holds 2 GBytes internal frame memory.  From this memory, a very 
small part, (only as much as required by one frame), is used for storing the 
frames for the live mode.  The remaining memory is used for sequence re-
cording. 
 
2.1.1 Live mode 

 
The camera images are continuously recorded and displayed.  This mode is 

optimal for defining image detail, adjusting the focus and setting up the 
various camera parameters.  Switch the camera to live mode by press-

ing the "Live" button. 
 
2.1.2 Prepare for recording 

When the camera parameters are adjusted according to the user’s needs 
while the camera is connected to the PC, the camera can be disconnected 
now from the PC and recording can be started via the trigger switch on the 
camera. 
 
2.1.3 Start recording 

After power up, the camera starts with the last used settings.  If you need 
another resolution/frame speed, the new parameters must be entered via the 
HiSpec control software. 
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To start the recording, press the red start recording button in the HiSpec 
control program 
 
 
2.1.3.1 Recording modes 

HiSpec has 2 recording modes.  The difference is the usage of the camera’s 
image memory.  
 

2.1.3.1.1 Non-circular recording mode 

The camera stops recording when the internal frame buffer is full. 
 

2.1.3.1.2 Circular recording mode 

The camera records frames in a circular mode, (i.e., the oldest frames are al-
ways overwritten by the newest), and waits for a signal to stop.  There are 2 
methods to stop recording: 
 

1. Apply a trigger signal, (rising or falling edge, depends on setting “Trig-
ger edge” in form “Camera Setup”), to the appropriate camera input 
connector. 

 
2. Press the Stop button in the HiSpec control program 

 
3 Installation of HiSpec 

 

3.1 Minimal system requirements (PC) 
 
For error-free operation of HiSpec the following minimum PC specifications 
are required: 
 

- Pentium III 1GHz CPU with MMX-technology 
- Windows 2000 or XP operating system 
- 256 MByte PC Ram 
- 10 GBytes Hard disk 
- 8 MByte graphic memory 
- Display with 1280 x 1024 pixels 
- GigaBit Ethernet Adapter 

 
For optimal operation of HiSpec, a PC with the following minimum specifica-
tions is recommended: 
 

- Pentium IV 1.8 GHz 
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- Windows XP / Vista 
- 1Gbyte PC Ram 
- 40 GBytes Hard disk 
- 32 MByte graphic memory 
- Display with 1400 x 1050 pixels24 Bit 
- GigaBit Ethernet Adapter 

3.2 Installation of the software 
 
The GigaBit Ethernet adapter and driver should be installed before the HiSpec 
software is installed.  For details see the GigaBit Ethernet adapter manual. 
 
Insert the HiSpec Setup-CD in the CD-Rom drive on the PC.  Start the se-
tup.exe program and follow the instructions through the rest of the installa-
tion process.  After successful installation some network settings may be ne-
cessary, depending on the actual network configuration.  These settings are 
needed for assigning an IP-address to the GigaBit Ethernet adapter and to the 
camera and described in the next chapters. 
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3.2.1 Assigning an IP-address to the GigaBit Ethernet adapter  

 
Assigning an IP-address to the adapter is only necessary, if no bootp-server is 
installed in your network. 
 
To assign an IP-address, perform the following steps: 
 
1. Close all HiSpec applications. 
2. Open the “Network and Dial-up Connections” window from the Windows 
Control Panel. 
 

 

 
 
Right click on the desired connection in the panel and click the “Properties” 
item.  The properties dialog for the connection, shown in the next figure on 
the next page, will be displayed. 
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- Highlight the Internet Protocol (TCP/IP) by clicking on the text-part, not 
on the check-box. 

- Click the “Properties” button.  The next dialog will allow you to assign 
an IP-Address and the subnet-mask of the Gigabit network-adapter.  
See details on next page in chapter “3.2.2.2.1 Assign IP-Address 

192.168.2.1 to the Gigabit Network adapter”. 
 
3.2.2 IP-Address of the camera 

Some settings are required depending on the Ethernet configuration. 
 
3.2.2.1 Bootp-server installed 

The IP-address for the camera is assigned by the server.  No other settings 
are necessary. 
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3.2.2.2 No bootp-server installed 

3.2.2.2.1 Assign IP-Address 192.168.2.1 to the Gigabit Network adapter 

After assigning the IP-Address 192.168.2.1 to the network adapter, set the 
subnet-mask to 255.255.255.0. 
 
Later on, in the HiSpec program, the IP-address 192.168.2.2 will be 

automatically assigned to the first camera used.  No other settings 

are necessary. 
 
3.2.2.2.1.1 Assigning a different IP-Address to the HiSpec camera 

The camera-network configuration file "mfggb.ini" contains a section called 
[CAMERA_REL] which resides in the installation directory. 
 
The entry: 
 
 ##CameraIP00=192.168.2.2 
 
Can be found in this section.  Delete the comment characters '##' and 
change the address "192.168.2.2." to the desired address.  
 
Example: 
 
The Network adapter has the IP-address 193.122.3.9.  An IP-address for the 
camera should be assigned, where the network part of the network adapter’s 
address and the part of the camera’s address must be the same.  How many 
octets cover this part depends on the network address class: 
 
Class A (beginning with 0…127) the first octet, 
Class B (beginning with 128…191) the first and the second octet, 
Class C (beginning with 192…223) the first, second and third octet. 
 
In our example, 193.122.3.10, which is Class C, would be OK, because 
192.122.3 are the same in both addresses. 
 
The entry in "mfggb.ini" could be: 
 
CameraIP00=193.122.3.10 
 
Be aware of address conflicts with other devices in the network! 
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3.2.3 The network configuration file  "mfggb.ini". 

As mentioned in the paragraph above, "mfggb.ini" resides in the installation-
directory and contains 2 sections. 
 
3.2.3.1 Section [CAMERA_REL] 

This Section contains the MAC Address of the used camera and network 
adapter.  The addresses will be registered by the HiSpec control program; no 
changes are to be done by the user. 
 
Example: 
 
AdapterMAC=00-0E-0C-4C-E2-F0 
CameraMAC00=00-50-C2-1D-7E-20 
 
Beside this, the camera’s IP-Address may be defined here.  See above for de-
tails. 
 
3.2.3.2 Section [IPORT_PARAMS] 

##InterPacketDelay=2000  // single camera on a Laptop computer 
##InterPacketDelay=6000  // camera is connected to an existing LAN 
##InterPacketDelay=100  // Default 
InterPacketDelay=3000  // Ethernet-switch 
PacketSize=1440 
RequestTimeOut=1000 
PacketTimeOut=1000 
AnswerTimeOut=1000 
FirstPacketTimeOut=0 
TabQuantity=2 
COMDelay = 100    // in us 
 
Depending on the system, use the appropriate parameter for the InterPack-
etDelay. 
 

3.3 Connecting the HiSpec to the PC and starting program 
 

To properly connect the camera to the PC please follow these steps: 
 

1. Connect the GigaBit Ethernet cable to the camera and then to the PC. 
2. Connect the power supply to the camera. 
3. Start the HiSpec Control program.  If it’s the first start after installation 

of the HiSpec software, two forms will be displayed for selecting the Gi-
gaBit Ethernet adapter and the HiSpec camera.  Please select the net-
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work adapter, click on “Apply” and select the camera and click on “Ap-
ply”. 

 
The HiSpec is now ready to operate. 
 
3.3.1 Selecting the network adapter 

The form for selecting the network adapter will be shown automatically after 
the first start of the HiSpec program after its installation.  You may load this 
form in the Camera menu, (“Select Network Adapter”) as well. 
 

 
 
Assign the network adapter for use with the program by clicking on the ap-
propriate line in the “installed network adapters” list and clicking on “Apply 
and proceed”.  In the next step, the form for selecting the camera will be 
shown automatically, if it’s a program start without successfully selecting a 
camera before: 



 
 

 
HiSpec Operator's Manual Version 1.11.9.docx  Page 21 of 72 

 
3.3.2 Selecting the HiSpec camera 

The form for selecting a HiSpec camera will be shown automatically after the 
first start of the HiSpec camera control program after its installation.  You 
may load this form in the Camera menu, (“Camera Select”), as well, if you 
want to switch to another camera. 
 

 
 
Assign a camera for use with the program by clicking on the appropriate line 
in the installed cameras list and clicking on “Apply (and proceed)”.  After the 
next automatic steps with the initializations for the hardware the system is 
ready for use.  
 
3.3.3 Camera name 

If you would like to use a name for your camera, you may enter this name in 
the “camera name” field of the ““Select Camera” line of the “Camera select”-
form.  By clicking on “Apply” this name will be used in the title of all other 
forms of the HiSpec program. 
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3.3.4 Multi camera operation 

If you want to use two cameras simultaneously, you have to copy the con-
tents of your HiSpec installation directory into a new directory and start HiS-
pec.exe in this new directory as a second instance of the HiSpec control pro-
gram.  By copying the HiSpec directory contents into another, separate direc-
tories and starting HiSpec.exe in this new directory, you may use up to four 
cameras simultaneously. 
  
For connecting the cameras with your PC you should use a Gigabit-Ethernet 
switch.  The following switches are recommended for use with the HiSpec 
cameras: 
 

• SMC TigerSwitch 86xxT family 
• 3COM 3C1740x (3800 famliy) 
• Dlink DGS-10xxTx 10/100/1000 family 
• SMC 8505 or SMC 8508 
• NETGEAR ProSafe 16 Port Gigabit Smart Switch 

GS716T 
 
 
3.3.4.1 Synchronizing cameras 

For synchronizing HiSpec cameras you only have to connect the sync output 
of a master camera to sync input of the slave cameras, as described in detail 
in “4.2.5 Enable Sync in” and “ARM or “Sync out” signal”. 
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4 HiSpec Operation 

 
The full range of functions available and all camera parameters may be set by 
means of the HiSpec software. 

4.1 The user interface 

The camera is completely controlled through the user interface.  All parame-
ters of the camera for recording, playback and saving the frames after record-
ing may be adjusted here.  After recording, stored sequences of images may-
be subsequently edited.  Start the software by double clicking on the appro-
priate HiSpec symbol on the PC desktop or choose the application in the win-
dows start menu.  The following screen mask will appear: 
 

 
 
Select modes of operation or change parameters by pressing a command-
button or by selecting an item in a pull down menu.  If the mouse cursor is 
moved slowly over the command buttons and symbols, information about 
each object will be displayed ("tool tip text"). 
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4.2 Selecting resolution, speed, gain, trigger, sync, ARM and white 

balance 
 

Click on the menu item "Camera" => "Camera Setup".  This form shown be-
low will appear: 
 
HiSpec cameras 

 
Setup adjustments for HiSpec cameras in the following form: 
 
 

 
 
 
Once the changes to the parameters for resolution and frame rate are set, 
click on "Apply". 
 

���� 

Changes of resolution or frame rate may alter the quality of rec-
orded images.  Be sure that you have saved your recorded images 
to file before applying these changes because afterwards the im-
ages may be destroyed or lost!  
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Now the new parameters will be sent to the camera.  All other parameters, 
e.g. shutter time or analog gain, will be sent immediately to the camera 
after entering. 
 
If there is no connection to the camera, an error message will appear.  Please 
make sure the camera is connected correctly.  If a link is not established by 
clicking on the reconnect button, read more in chapter “7, Troubleshooting”. 
 
4.2.1 Gain 

The gain may be adjusted with a slider up to 4.  But please note: the quality 
of the image decreases the more you increase the gain. 
 
4.2.2 Black level 

With the black level parameter, (controlled with slider or text field), you may 
adjust the camera’s image sensor base black level.  The base black level must 
be set to a value between 0 and 255.  Setting to the correct value, the sensor 
will deliver the pixel value 0, (which means totally black), for a complete 
black image. 
 
If the value is too small, the sensor will deliver a pixel value above 0, (which 
means gray). 
 
If the value is too big, the sensor will deliver a pixel value 0, (totally black) 
for images that are gray and not completely black. 
 
The white balance form, (for color cameras), or the histogram form, (for mo-
nochrome cameras), is a good tool for adjusting the black level: 
 
In live mode, close the lens of the camera for getting a completely black im-
age, adjust the black level until the black line in the white balance or the his-
togram touches the “min” border of the chart. 
 
4.2.3 „Lin Log“ (for colour cameras only) 

With the “Lin Log” parameter you may adjust the sensor’s characteristic in 
order to avoid overexposure of very bright parts in the image. 
 
If the slider is moved to 1, („Lin“), the sensor’s characteristic is linear and 
normal illuminated scenes will be properly displayed. 
 
If there are very bright areas in the scene, then the image will be overex-
posed and details may be lost.  In this case you should move the slider to-
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wards “log”(arithmic) whereby details in bright parts of the image will become 
visible again.  The correct  setup value depends on the brightness spreading 
of your motif.  In normal illuminated scenes you should use “Lin”. 
 
4.2.4 Low Light Mode 

In low light mode the camera's exposure-time is extended up to 1023 millise-
conds in order to increase its sensitivity.  This mode is good for setting up the 
frame size and the focus in live-mode.  Select your exposure-time with the 
slider "shutter time" or input it directly in the appropriate number-field.  Low 
light mode will be automatically finished if a recording is started. 
 
4.2.5 Enable Sync in 

With “Sync in” enabled it is possible to synchronize a HiSpec camera with 
other HiSpec cameras.  
 

- Connect the Sync out of your HiSpec master camera to the slave cam-
eras,  

- Connect the ground of the master camera with the ground of the slave 
cameras, 

- Select a frame rate for the slave cameras that is slightly above the 
master cameras frame rate.  Thus the slave cameras will be synchro-
nized with the master camera. 
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4.2.5.1 Frame rates of master and slave camera 

If you synchronize a slave camera by a master camera, then the frame rate of 
the slave camera must be slightly above the master camera’s frame rate, (as 
mentioned before), otherwise the slave camera will not provide the same 
frame rate as the master camera. 
 
Example: 
 
You want to record with 500 frames per second.  Adjust the master camera to 
the desired 500 fps, select 506 fps for the slave camera.  Then the slave 
camera will deliver the master camera’s frame rate (500 fps)! 
 

� 

If “Sync in” is enabled and no “sync in” signal is provided, the cam-
era will not record and timeout will occur! 
 
The frame rate of the slave camera must be slightly above the mas-
ter camera’s frame rate: 
 
Slave camera should be set up to frame rate that is at least 2 fps 
higher than the master camera’s frame rate. 

 
4.2.6 ARM or “Sync out” signal 

You may choose between “ARM” or “Sync out” signal for pin 3 of the output 
connector, (see 8.2.1 Power Signal Connector of HiSpec Page 63). 
 
4.2.6.1 Sync out activated 

If you select “Sync out”, it is possible to synchronize other HiSpec cameras.   
The rising edge of the signal provided on pin 3 shows the beginning of the 
exposure of the master camera’s image, the falling edge the end. 
 
4.2.6.2 ARM activated 

If you select “ARM”, you get a signal if the camera is ready for triggering in 
the circular recording mode. 
 
With the two check-boxes on the right side of the Sync out/ARM you may de-
fine if ARM is active high or low.  Please note: this does not apply to the 
“Sync out” signal. 
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4.3 Set up a scene 

 
Click on the "Live"-Button to get a live image from the camera.  The camera 
may now be focused and aligned for the details of the scene.  You may use 
low light mode to increase the camera's sensitivity, (available only in live 
mode because on the other side the frame rate will be decreased!). 

4.4 Recording in non-circular mode 
 
Non-circular mode is selected in menu "Record" => "record setting" => "non 
circular..".  To start, click on the red button.  Now the camera starts recording 
and stops when the internal buffer is full.  During recording, the recorded 
frames are displayed simultaneously.  After recording, the first, (oldest), rec-
orded frame will be displayed. 
 

4.5 Recording in circular mode 
 
Circular mode should be used if a trigger is applied.  The trigger may be:  

 
- a TTL trigger signal,  
- the ImageBLITZ software, 
- the clicking on the stop button in the HiSpec control software. 
 

A trigger is necessary if images are needed before and/or after an event.  The 
trigger defines the point of time of your event. 
 
Circular mode is selected with menu "Record" => "record setting" => "circu-
lar..".  There are 2 methods to start and 3 various methods to stop the circu-
lar recording as described in the next chapters of this manual.  In circular re-
cording mode the recorded frames are displayed simultaneously.  The number 
of frames that will be recorded before the trigger, called “pre-trigger 
frames”,  is determined in menu  "Record" => "record setting" => "circu-
lar.."=> "Trigger Position ,Before [Frames]". 
 
After recording, the frame immediately after the trigger will be displayed, the 
timestamps will be set in relation to the point of time of the trigger-moment, 
i.e. the first frame after the trigger is set to 0 ms.  Negative values indicate 
that the displayed frame was recorded before the trigger, positive values indi-
cate frames after the trigger, called “post-trigger frames” 
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4.5.1 Start recording 

There are two ways of starting a recording: 
 

1. Press the Start/Stop recording switch on the camera.  
 
In this case, a reconnect has to be accomplished after the completion of 
the recording sequence in order to save the chronology of the pictures. 
 
Press the start recording button in the HiSpec control program. 

 
The internal camera state LED, (see 1.6.1.2.1 on page 11), will start flashing 
orange.  This indicates that recording is in progress and the camera is waiting 
for the trigger to complete the sequence. 
 
4.5.2 Stop recording 

There are three ways to stop recording: 
 

1. Press the Start/Stop recording switch of the camera. 
2. Apply a trigger signal to the appropriate camera input connector. 
3. Press the stop button in the HiSpec control program. 

 
The internal camera state LED, (see 1.6.1.2.1 on page 11), stops blinking 
orange.  The sequence is complete after the post-trigger frames have been 
recorded. 
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4.6 Playback of a sequence 

 
The frames in the camera may be accessed after recording.  If the camera 
has been disconnected from the PC's GigaBit Ethernet it must now be recon-
nected and the reconnect button in the HiSpec control program 
must be clicked on. 
 

� 

It is very important to press the reconnect button after the 
camera is reconnected with your system.  If this button is not 
pressed after reconnection, the chronology of a meanwhile rec-
orded sequence may be lost! 
 
The same applies to a completed recording session that has 
been started with the camera’s trigger switch. 

 
Click on one of the forward or backward buttons.  Now the frames will be dis-
played.  Alternatively the play settings menu may be used for selecting the 
frames. 
 

 
 
The frame counter shows the position within the recorded sequence. 

The time stamp indicates the position relative to trigger. 
 

Use  
 
 
 
Use this “frame slider” to browse through your recorded sequence. 
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4.7 Editing and saving a sequence 

 
In high speed recordings usually only a portion of the frames contain relevant 
information.  Therefore, it is useful to save only that range of frames which 
contains this essential information. 
 
There are 2 methods of selecting the essential range of frames for saving: 
 

- Enter the range of the frame numbers in the "from" and "to" input field 
of the "Save" or the "Make AVI" menu. 

- Alternatively you may enter the frame range by means of mouse-button 
and control keys as described in the next chapter. 

- The selected range will be shown as a blue bar in the frame slider. 
- Create a list of frames in the "Play settings" menu. 
-  

The sequence may now be saved as single bmp-files in the "Save" menu or as 
an AVI-file in the "Make AVI" menu.  See chapter 5.4.2 and 5.4.3 on page 41 
and page 43 for details. 
 
4.7.1 Editing a sequence by using frame slider or keys 

If the frame slider has the focus you may use the mouse buttons or the key 
“b”, “e” and “l” for editing a sequence. 
 

� 

This method works only if the frame slider has the focus!  Click on 
the frame slider for getting the focus 

 
4.7.1.1 Set the beginning of a sequence 

 
 
Press the right mouse button or the key “b”.  The actual frame number, 1068 
in the picture above, will be set as a start value for the range of frames.  The 
selected range will be shown as a blue bar in the frame slider. 
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4.7.1.2 Set the end of a sequence 

 
Press the shift key and the right mouse button or the key “e”.  The actual 
frame number, 1117 in the picture above, will be set as an end value for the 
range of frames.  The selected range will be shown as a blue bar in the frame 
slider. 
 
4.7.1.3 Copy the selected range into the frame list 

Press the key “l” for copying the selected range into the frame list. 
 

4.8 Retrieving saved bmp-files 

 
If the saved bmp-files are to be viewed, select the directory, the filename and 
the desired frame numbers in the "File" => "Load" menu (chapter 5.4.1 on 
page 39).  Now the image source for displaying frames is the selected directo-
ry with the appropriate files.  
 
This is indicated by the symbol in the status area of the HiSpec con-
trol-program. 
 
The playback buttons or the "Play settings" menu allow navigation through 
the image files as described in chapter 4.6 on page 30. 
 
The HiSpec camera is set as image source by clicking on the "Live" button or 
the red "Start Recording" button.  This is indicated by the camera 
symbol. 
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4.9 White balance / histogram / length of the check line 

 
Good illumination is extremely important for optimal true color display.  Best 
results are achieved by using daylight or halogen light.  For recalibrating the 
color correction, click first on "Live" and then in the menu Camera Setup on 
the button "white balance".  The following screen mask will be shown: 
 

 
 

� 

White balance is available for color cameras only.  For 

black & white cameras a histogram will be provided in-

stead.  The histogram contains only a chart without red, 
green and blue.  
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4.9.1 Do the white balance manually 

Adjust the size of the green check-line, which is automatically displayed in the 
camera image, and move this line over a white area using the mouse.  (Click 
and hold on the line and move it). 
 

 
 
The values of the pixels along this line will be shown as three curves – red, 
green and blue.  Using the "R", "G" and "B"-sliders, move the three curves 
until they are nearly congruent as shown in the figure above. 
 
4.9.2 Automatic white balancing 

Take a picture of a scene that contains in its middle area mostly white.  Click 
on the “Auto” button. 
 
4.9.3 Save the white balance values in the camera 

Click on "Apply" to assume these values and to save them in the camera. 
Click on "Close" to close the form. 
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� 

Multiple white balancing adjustments may be performed.  If the im-
ages are saved to a file, it is no longer possible to correct the color 
of these image-files.  Only frames downloaded from the camera are 
correctable before saving. 

 
 
4.9.4 Provide the length of the check line 

The green check line may be used for approximately determining the length 
of distances between the starting point and the endpoint of the line.  The val-
ue will be shown in the field “length of the check line”.  This value and its 
physical unit may be calibrated by entering your values in both fields. 
 
If you know e.g. in the upper example, („204 pixel“), that this corresponds to 
1.5 inch, then input 1.5 inch.  From now on the pixel will be converted into 
inch. 
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5 Controls and menus in the HiSpec software 

 
There are several menus and controls in the HiSpec program.  Each will be 
described in the following chapters 
 

5.1 Moving the camera image 
 

Click with the left mouse button on the camera image.  Hold the button and 
move the mouse.  The image will move in the desired direction. 
 

5.2 Zoom in and zoom out 
 

For zooming, use the left vertical scrollbar.  The range of the zoom factor is 
from 0.1 (smaller) to 10 (bigger) than the original. 
 

 
 
Click on the zoom icon for the original size.  The number next to the zoom 
icon  
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indicates the actual zoom factor.  Double-click on the icon to fit the image in-
to the form. The icon gets green to indicate this. 
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5.3 Brightness and contrast 

The brightness of the image, (right top vertical scroll bar), and the contrast, 
(right middle vertical scroll bar), are set.  By clicking the scroll bar symbols 
with the left mouse button, the initial state of the appropriate parameter is 
set.  Adjust the base value for the contrast computation using Contrast Base.  
This is needed only in special light conditions. 
 

 

 

5.4 Menu File 

 

 
 

� 

Changes to contrast and brightness are relevant for the saved 
frames!  
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The File menu allows: 
 

- reloading bmp-files for display, 
- start saving images as bmp-files,  
- create an AVI-file and 
- exit the program 

 
5.4.1  Reload bmp-files 

 

 
 
HiSpec loads only bmp-files with 5 digit name endings.  Files with the same 
part before these 5 digits are assumed to be from the same saved sequence. 
To reload sequences, (or a part of it), select the volume, the directory and the 
filename without the digits. 
 
There are 2 methods of selecting the single files to be loaded: 
 
Load loop 
Load frame list 
 
5.4.1.1 Load loop 

Click on the radio button "Load loop". 
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Entries can be made in the fields “From” and “To“ by clicking on files on the 
file list with the mouse: 
- Click the contents of the “From“ field with the left mouse button, (number 

1 in our example).  The background of the figure is blue. 
- Click on the desired image file with the left mouse button, e.g. 

frames.bmp. “14“ is added to the “From“ field.  The blue background dis-
appears. 

- Proceed in the same manner for the field “To“. 
 
5.4.1.2 Load frame list 

 
Click on the radio button "Load frame list".  The list may be edited in the 
menu "Play settings", (chapter 5.8 on page 61).  Only the files whose num-
bers are included in the frame list will be loaded and displayed. 
 

 
 
By clicking “OK“ the first file is loaded into the main window.  Use the replay 
buttons as described in 4.6 on page 30 for displaying the whole sequence. 
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5.4.2 Save images to bmp-files 

 
 
Select a name from the file list below the bmp name field by clicking on it or 
by entering a name on the keyboard.  On the right side of the window it is 
possible to set the hard disk drive and the path with the mouse.  
 
It is essential to remember that if more than of 2 characters for the name are 
used, the performance may decrease.  Nevertheless, any name may be used 
which conforms to Windows.  HiSpec extends these characters by a 6-digit 
figure which corresponds to the frame number.  At present only “bmp“ data is 
supported, i.e. the name suffix is permanently set to “.bmp“. 
 
5.4.2.1 Save Loop 

Click on "Save Loop“. 
 
The numbers of the images in the range of “From“ and “To“ fields, (including 
the values themselves), are written to a file by clicking “OK“.  The frame 
numbers may be also entered by using the frame slider and mouse-buttons or 
keys as described in “4.7.1 Editing a sequence by using frame slider or keys”. 
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5.4.2.2 Save frame list 

 
Click on “Save frame list“. 
 
The numbers of the images shown in the list are written to a file by clicking 
“OK“.  This list may be edited in the pull down menu “Play Settings”, de-
scribed in chapter 5.8  on page 61. 
 
In both cases, (“from ... to“ and “Frame list“), each image and its file name 
are displayed while being stored.  If the "display frames" check box is NOT 
active, the frames will not be displayed.  In this case the saving procedure 
will be faster. 
 
If a file with the same name already exists, a response to a message box is 
required. 
 
Click on:  
Yes The file and all the following files will be overwritten. 
No The image will not be stored and, if possible, the procedure con-

tinues with the next image. 
Cancel The image is not stored and no further images will be processed. 
 
The recording will be written to a file either with or without an image caption 
depending on whether “info line“ has been switched on or off in the “View“ 
menu. 
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5.4.3 Save images to a RAW file 

Different from saving images to bmp-files, several frames are stored in a sin-
gle, so called “raw file”.  This file contains a header, which describes the 
frames that are stored in the file as well as the frames themselves.  The 
frames are raw, i.e. they are stored in the same format as they were up-
loaded from the camera, without any conversion and filtering.  If the camera 
holds frames with a Bayer pattern, then these frames will be stored without 
any Bayer filtering.  
 
The selection of the frames to store operates in the same manner as de-
scribed in chapter 5.4.2.1. 
 

5.4.4 Reload a RAW file 

For reloading frames, that are stored in a RAW file, use the “Load RAW..” in 
the files menu. The raw frames will be extracted from the file, converted to 
color and white balanced if necessary and displayed. You may export the 
frames to an AVI-file or bmp-files as well, see chapter Error! Reference 
source not found.5.4.  To indicate, that frames from a RAW file are dis-
played, the RAW file symbol is displayed left of the reconnect button: 
  

 

 

5.4.5 Format of the RAW header 

All numbers are in decimal format 
 
 Example Number 

of chars 

Remark  

[RAWHEADER]  32   
Format_Identifier=  MRAW 32 A CRLF is in-

cluded for delim-
iter ,all fields left 
aligned 

 

Version= 00001.00000 32   
Vendor_id= Mikrotron GmbH 32   
Offset to first frame= 1310720 32   
Colour mode= 0  32 1=BAYER 

0=MONO 
 

Frame_width_in_pixel= 01280 32 1280  
Frame_height_in_pixel= 01024 32 1024  
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Bits per pixel= 24 32   
Bayer Filter Start= GR/RG/BG/GB 32   
Bayer Factor Red= 1.00000000 32   
Bayer Factor Green= 1.00000000 32   
Bayer Factor Blue= 1.00000000 32   
GammaRed=  32   
GammaGreen=  32   
GammaBlue=  32   
Param_1=  32   
Param_2=  32   
Param_3=  32   
Frame rate= 00000100.0 32   
Absolute timer basis= 49,9131944 32 [µs]  
Comments= Experiment 26 96   
CompleteFixedInfoPart= 1280x1024, 500 

Hz, 564 µs, *1.5, 
MotionBLITZ Eo-
Sens Cube 
#00000, V1.9.28 

96   

RecFreeInfoTexte= -“Infotext...“ 96   
Local Basetime= 2008-12-17 

23:50:00   
32 Timestamp for 

value 0 of the 
absolute timer 

 

     
NumberofSequences= 00001 32   
[SEQUENCES]  32   
NumberofFrames_00= 00000001000 32 First sequence  
TriggerFrameNum-
ber_00= 

00000000050 
(1…x) 

32   

Reftim1_00= 0000023111 32   
  32   
 NumberofFrames_01=  32 Second sequence  
TriggerFrameNum-
ber_01= 

00000001000 32   

Reftim1_01= 00000001050 
(1…x) 

32   

     
NumberofFrames_02= ... ….  Third and next 

sequences 
 

     
 

 

5.4.6 Make AVI File 
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Select the AVI-filename, the numbers of the frames to be compressed and the 
compressor-type by clicking on the "Compressor-setup" button. 
 

 
 
If only a special region of the sequence is to be processed, select this region 
by clicking on the "clipping" check box.  A rectangle named "AVI clipping 
area" will be overlaid in the camera image.  Adjust the size as needed and 
move the rectangle over the region of interest with the mouse.  Once all pa-
rameters have been set, click on "Make AVI.." 
 
The AVI progress bar and the estimated time to completion will appear.  
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If you click on “Cancel” while an AVI is created, the AVI will hold only the 
frames up to the point of time of your cancellation. 

5.5 The Camera menu 
 

 
 
Within this menu, you may:  
 
- with „Camera Setup“ check and change the camera’s parameter.  See 

chapter 4.2 „Selecting resolution, speed, gain, trigger, sync, ARM and 
white balance“ for details.  
 

- with „Camera Select“ connect with the camera via the Ethernet.  See chap-
ter 3.3.2 „Selecting the HiSpec camera“. 
 

- with „Select Network Adapter“ select the adapter as described in chapter 
3.3.1 “Selecting the network adapter”. 
 

- with „Standby“ set the connected camera into the standby mode.  More in-
formation to this topic you will find in chapter Error! Reference source 
not found.” 
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5.6 The View menu 

 

 
 
5.6.1 Raw 

The image is displayed as delivered from the camera without any modification 
and no Bayer color-calculations.  Thus in Raw mode always a black and white 
image will be seen. 
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5.6.2 Display while recording 

Disable this point if the images are not to be displayed during recording. 
 
5.6.3 Check camera temperature 

This menu is visible, if the configuration file “CameraTemperatureLimits.ini” 
contains a temperature limit unlike zero for the currently used camera. 
After activating this point, in intervals of 1 minute the internal camera tem-
perature will be measured and checked against the limit.  If the temperature 
is in the normal range, the word „Temp“ next to the reconnect button will be 
shown in green letters, if the temperature is high in red letters.  In this case 
the camera should be cooled.  In the form “info” there is additional informa-
tion about the camera’s temperature. 
 
After starting the MotionBLITZ program, this menu point is always deactivated. 

 
5.6.4 Marker 

Up to 4 markers may be enabled.  Markers are magenta colored lines that 
overlay the camera image.  The size may be adjusted and moved with the 
mouse.  Markers are used for tagging the position of an interesting part in the 
replayed sequence. 
 

� 

Markers have no relevance for the saved frames!  

 
 
5.6.5 Info line 

Attaching information to the recorded images is switched on or off.  The in-
formation portion is displayed as follows: 
 
 

 
 
The upper part of this section taken from the HiSpec main window shows the 
remaining part of a recording and the information portion.  It contains the fol-
lowing fields with information at the time of recording: 
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Field: Content in the example: 
Date 21.01.2009 
Time 18:08:01 
IRIG-B time code (1), contains 
3 characters day of the year 
6 characters for time of day, 
GMT 

Not implemented 

Frame number 6274 
rel. time after trigger [ms] -1774,0 [ms] 
Sequence number (2) S01 
Digital input (binary representa-
tion) 

Not implemented 

Analog input (decimal format) Not implemented 
Resolution,  width x height 512x512 
Frame rate 1000 Hz 
camera type HiSpec 
Serial number of camera #00105 
Software version  V1.7.34 
Free text to be entered via “Info 
text“ 

This is the info text. It may be edited 
in View => Info text 

 
This information portion is stored along with the frames while recording in the 
image information block in the first image-line to save on frame memory.  It 
is interpreted from that structure for playback and then attached to the im-
ages. 
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5.6.6 “Info text...“ 

Open the window “Edit Info Text“: 
 

 
 
The text entered here and confirmed by clicking “OK“ is added to the informa-
tion portion in the recording sequence. 
 
5.6.7 Language 

English or German may be selected as language for all texts in the program.  
 

5.7 Record settings 

 

 
 
The recording mode may be selected.  There are 2 modes: 
 
Non-circular mode 
Circular mode 
 
5.7.1 Non-circular mode 

Recording proceeds  
 
- until the end of buffer is reached and stops afterwards or, 
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- until the recording is aborted before by clicking on the “Stop” button or 
pressing key F12. 

 
5.7.1.1 Without trigger 

 
 
5.7.1.2 With trigger facility 

 
 
 

� 

During a non circular recording session with triggering actual 
images are shown as long as the camera provides them on 
account of the active trigger.  While waiting for the next trig-
ger there are now images shown. 
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5.7.1.2.1 Recording while trigger is active 

 
 
As long as the trigger is active, recording will proceed.  When the trigger is 
made inactive before the image buffer is full, the camera will wait for the next 
trigger.  Not until the end of the buffer is reached does the recording end, (or 
if the recording was aborted before by clicking on the “stop” button or press-
ing the F12 key). 
 
The trigger may be: 
 

1. An external trigger signal connected with the camera’s trigger input, 
provided that „Trigger With External Signal“ in „Record Settings” is acti-
vated.  The active edge or the active state of the signal may be selected 
in the menu “Camera Setup”, (Selecting resolution, speed, gain, trigger, 
sync, ARM and white balance). 
 

2. Changing of the contents in a specific part of  the actual recorded image 
if ImageBLITZ is used, i.e., “Trigger With ImageBLITZ” is activated, 
(see chapter  5.7.2.1.2 “ImageBLITZ” for details of ImageBLITZ). 
 

With this trigger setting, the active state of the trigger is essential, not the 
edge. 
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5.7.1.2.2 Fixed number of frames per trigger (burst trigger) 

 
 
 
For each trigger edge a preset number of frames will be recorded.  The num-
ber may be chosen between 1 and 1022. 
 
Enter the number in the input field or move the slider into the desired posi-
tion.  In the figure above 100 frames per trigger edge are selected. 
 
After every recording, which was initiated by the trigger edge, the camera will 
wait for the next edge as long as the end of the memory is not reached. 
 
After reaching the end of the memory, the recording is completed.  Alterna-
tively the recording may be aborted via the Stop button or F12. 
 
As described in the chapter before, the trigger could be an external trigger 
signal or the ImageBLITZ software. 
 
With this trigger setting, the active edge of the trigger is essential, not the 
state. 
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5.7.2 Circular mode 

 

 
 
The camera will record in a circular mode, i.e., the oldest frame is overwritten 
by the newest.  After triggering or the circular recording has been stopped by 
clicking the stop button or pressing the key F12 as many frames as defined in 
the input-field "Trigger Position, Before [Frames]", (2025 in our example), 
will be kept and the rest of the frame buffer will be filled up with frames.  
With the slider you may vary the trigger position from the first frame, (“1”), 
to the last possible frame, (“4049”), as well. 
 
If you select “Before [Percent]” the before frames to total frames ratio will 
be retained if the total number of frames is changed, (e.g. by changing the 
frame size). 
 
5.7.2.1 Trigger modes 

HiSpec comes with two trigger modes, which may be selected independently.  
Select an external signal and/or ImageBLITZ by clicking on the appropriate 
checkbox. 
 

5.7.2.1.1 External trigger 

If external trigger is selected, a rising or a falling edge, depending on the set-
tings in the menu “camera setup”, will bring the recording to completion. 



 
 

 
HiSpec Operator's Manual Version 1.11.9.docx  Page 55 of 72 

 
5.7.2.1.2 ImageBLITZ 

If ImageBLITZ is selected, changing of the contents in a specific part of the 
actual recorded image will bring the recording to completion.  This specific 
part is called the “ImageBLITZ window”.  The parameters of ImageBLITZ are 
adjusted in the “Recording settings” menu in “Live” mode.  The ImageBLITZ 
window is shown as a green, red or yellow rectangle in the displayed frames.  
 

 
 
Don’t move or alter the ImageBLITZ window while recording.  Movements 
while recording have no effect. 
 
5.7.2.1.2.1 ImageBLITZ parameters 

If ImageBLITZ is activated, the HiSpec camera compares the image detail of 
the actual frame with the image detail of the reference frame.  If the differ-
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ences within this image details exceed a limit, ImageBLITZ triggers (“releas-
es”). 
 
These two parameters for adjusting the ImageBLITZ may be set manually by 
entering the values in the release parameters fields or automatically by click-
ing on “auto adjust”. 
 
5.7.2.1.2.1.1 Pixel value difference 

This parameter defines the absolute limit for the difference in the gray values 
within the image details.  The value range is 1 to 255.  
 
With a small value small changing in the image detail let the ImageBLITZ 
trigger, with a big value the ImageBLITZ trigger gets less sensitive.  Under 
normal conditions, this value should be between 10 and 70. 
 
5.7.2.1.2.1.2 Relative object size 

This parameter defines the relative size of the area within the ImageBLITZ 
window that must be different from the reference frame before ImageBLITZ 
triggers.  The value range is 1 to 100 percent.  If you use a small value, e.g. 
5, then ImageBLITZ triggers when 5% of the image details are different.  
 
5.7.2.1.2.1.3 ImageBLITZ Reference frame 

The ImageBLITZ reference frame is the first frame of a recording sequence, 
i.e. in Live mode the first frame after starting Live, in record mode the first 
frame after starting the recording.  Using the auto adjust feature, the refer-
ence frame is the next frame after clicking on “auto adjust” 
 
5.7.2.1.2.1.4 ImageBLITZ window colors 

The color of the ImageBLITZ window borderlines is used for indicating the 
state of ImageBLITZ: 
 
Color Meaning 
  
Green ImageBLITZ is active and waiting for a trigger situation. 
Red ImageBLITZ is active and has triggered. 
Yellow ImageBLITZ is not active, (the system is not in Live- or recording 

mode). 
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5.7.2.2 Multi sequence - optional 

The frame memory may be divided into up to 16 same-sized memory ranges 
for sequences, called multi sequence mode.  Each memory range is then filled 
by a trigger event, i.e., by the occurrence of the external trigger signal or the 
ImageBLITZ trigger.  After a trigger event the post-trigger frames will be rec-
orded and the camera switches to the next sequence, beginning the recording 
of the pre-trigger frames.  Thus the recording proceeds till all sequences are 
complete. 
 
If a trigger event occurs before the predefined number of pre-trigger frames 
are recorded, the number of pre-trigger frames will be less than predefined, 
whereas the number of post-trigger frames will be as expected. 
 
If a multi sequence recording will be stopped with the camera’s HiSpec control 
program’s Stop button or key F12, HiSpec fills the rest of the sequences that 
are not yet recorded, with the number of post-trigger frames and brings the 
recording to an end. 
 
Multi sequence mode is provided only by means of the HiSpec control pro-
gram.  There is no possibility to start a multi-sequence recording session if 
the camera is not online. 
 
There are 5 different numbers of sequences: 
 
- 1 
- 2 
- 4 
- 8 
- 16 
 
For establishing the multi sequence mode, click on the ComboBox “number of 
sequences“ in the form “record settings“ with the left mouse button and se-
lect the number of sequences you would like to record.  
 
Please note: This ComboBox is only available in the “circular buffer” recording 
mode! 
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After selecting the number of sequences, during the next recording session 
the number of sequences will be represented by sequence command buttons, 
labeled with the sequence-number: 
 

 
 
 
The number of the sequence, that will be recorded actually, is represented by 
the green color of the sequence command button.  In the example above, 
ImageBLITZ had triggered while recording the first sequence.  The command 
buttons are disabled during the recording session. 
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After finishing the recording session, the sequence command buttons are 
enabled, by clicking on a button you navigate to the frame immediate after 
the trigger event in the appropriate sequence. 
 

 
 
 
 
 
 
5.7.2.3 Auto Save 

If the Auto Save mode is activated, frames will be stored to hard disk in the 
RAW data format automatically after the end of a triggered circular recording 
sequence.  After completion of storing the frames, a new recording sequence 
will be started.  Auto saving will be ending when the user stops the recording 
sequence, (by pressing the F12-key or clicking on the stop button), or if the 
disk runs out of space.  
 
Parameters for Auto Save could be adjusted in the form Auto Save.  You may 
start the form by clicking on the checkbox “Show Form Auto Save” in the Re-
cording Settings form. 
 
The number of frames before the trigger point of time and the number of 
frames from the trigger point of time on could be adjusted as well as the file 
name for the saved frames.  The selected file name will be extended by a 
time stamp, that holds the instant of time, when auto saving started: 
 

Click here to use the frame slider for all sequences or one sequence only 
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The name of the file, that contains the automatically saved frames, has the 
following format: 
 
Base name / Delimiter / YYMMDD / Delimiter / HHMMSS / .rec 
 
The base name is declared in form Auto Save, e.g. in the screen shot above 
“test”, the delimiter is the sign “_”, YYMMDD means year, month, day and 
HHMMSS means hour, minutes, seconds.  
 
An example of the name of file, which contains frames, which were auto 
saved starting on February 9th, 2009 at 16:09:27 is: 
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test_090209_160927.rec 
 
 

5.7.2.3.1 Start an Auto Save session 

If you click on the checkbox “Auto Save active” in the form “Recording Ses-
sions”, the next recording sequence, that will be started (either by clicking on 
the red  
 
Start Recording button or by pressing the key F5), will be an Auto Save ses-
sion.  
 
This will be indicated by the word “AutoSave” next to the start recording but-
ton in red letters: 
 
 
When the Auto Save session is stopped, the checkbox “Auto Save active” will 
be deactivated automatically and the “AutoSave” indication next to the start 
recording button disappears.  If you like to start another Auto Save session, 
you must click at the check box “Auto Save active” again. 
 
 

5.7.2.3.2 Stop an Auto Save session 

An active Auto Save session can be stopped by the user: Press the F12 key or 
click the stop button.  The camera’s recording session will be ended and the 
frames saved to hard disk.  After completion of the saving, the Auto Save 
session is finished. 
 
If the hard disk runs out of space, an Auto Save session will be stopped by 
the system automatically. 
 

5.7.2.3.3 Show the saved frames 

After completion of an Auto Save session, each recording sequence of the 
camera is stored in a different file. Select the appropriate file in the menu 
“file” => “Load raw..”. See chapter “Reload a RAW file” for details. 
 

5.8 Play settings 

 
In this form the number of the images that shall be displayed is defined.  This 
is valid for frame selection in the "file save" and "file Make AVI" form as well. 
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The behavior during playback in forward and reverse sequences is influenced 
by the radio buttons; it is possible to set a time delay between the display of 
individual frames. 
 
5.8.1 Display of individual frames  

Click on the radio button “Single frame“.  The frame with the number shown 
in the entry field "Single frame” is retrieved from the HiSpec frame memory 
and displayed.  Any image desired may be loaded from the memory by enter-
ing the frame number into the entry field or by operating the “frame slider” in 
the main form. 
 
5.8.2 Display loop “from ... to“ 

Click on “from“. Enter the frame number of the beginning and ending of the 
desired range or select the range by using the “frame slider” and mouse but-
tons, as described in 4.7.1 ”Editing a sequence by using frame slider or keys”. 

By clicking  “Forward playback“ or  “Reverse playback“ the frames 
within the selected range will be loaded from the HiSpec frame memory and 
displayed in an infinite loop. 
 
 
5.8.3 Frame List 
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The frame numbers selected via "Single frame" or “from … to” can be added 
to the frame list by pressing the “=> frame list“ button.  
 
By pressing “Delete“ the numbers which were marked previously with the 
mouse can be removed.  
 
The contents of this list can be used for saving loading images from files, (in 
the “File“ window), for saving frames as an AVI, (in the “File” -> “Make AVI…” 
menu), or for defining a playback sequence. 
 
5.8.4 Display loop with frame numbers from frame list 

Click on “frames list“. By clicking  “Forward playback“ or   “Reverse 
playback“ all frame numbers are processed on the list in an infinite loop, i.e. 
the recorded images are loaded from the HiSpec frame memory and dis-
played. 
 
5.8.5 Last frame number 

Depending on the size of the frame memory and the current frame size, (line 
length and number of lines), the last permissible frame number xxx is deter-
mined and displayed in “Last frame number“.  It is not possible to exceed this 
number in the display loop or when displaying individual frames. 
 
5.8.6 Slow motion (time delay in display) 

To playback a sequence in slow motion, select the desired time delay in milli-
seconds in the entry field “Delay [ms]:“.  The time value may be entered in 
the field directly or changed by using the appropriate horizontal scrollbar.  
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5.9 Info form 

 

 
 
In the Info form details about the HiSpec control software and the firmware of 
the actually connected camera are displayed. 
 
The first part holds the HiSpec control software version number and the copy-
right statement. 
 
The second part holds information about the connected camera: 
 
- Serial number of the camera 
- Model type (HiSpec) 
- Sensor type 
- Firmware-Version 
- MAC Address 
- IP Address 
- The size of the frame memory 
- Features 

 
C Colour sensor 
MS Standard recording time 
HG Hi-G version (crash proofed) 
IB ImageBlitz 
MS Multi-sequence 
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6 Maintenance 

 
During normal use an occasional cleaning of the optical path is necessary.  In-
formation about cleaning the lens is provided by the respective manufactur-
ers. 
 

6.1 Cleaning of the HiSpec infrared filter 
 
HiSpec, (color), contains a filter to suppress infrared light.  Dust and dirt, 
which may deposit on this filter is best removed by means of an oil free air 
pressure spray or with a lens cleaning tissue.  Sticky residue and fingerprints 
may be cleared away with medical alcohol. 
 

���� 

Improper cleaning agents may damage the filter.  Such damage 
may alter the quality of the images. 

 
 

� 

Infrared light is part of the visible light spectrum and warps the 
color in the camera images.  Therefore it is necessary to illumi-
nate infrared light with the filter. 
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7 Troubleshooting 

 
Any known software errors are listed in the release notes. 
 
Main problems: 
 
Q:  The HiSpec establishes no camera link.  An error message box ap-

pears or “timeout” will be indicated.  What to do? 

 
A: Check if the camera and the PC are connected via the Ethernet. Check if 
the Camera LED's are in a state as described in chapter 1.6.  Click on the 
"Reconnect" button in the HiSpec control program. If the color of this button 
does not change to green (=connected), switch the camera off, switch the 
camera on, wait until the lower LED turns green and try again. 
 
A: Check if the camera LED’s indicating the ready-to-operate state (both 
LED’s must be green or orange as described in chapter 1.6.1.2. 
 
A:  Check if the windows firewall allows HiSpec to work!  If the fire-
wall is active, set it to inactive, close HiSpec and start it again.  If it 

works now, you may configure HiSpec in the windows firewall as an 

exceptional program and activate the firewall again. 

 
A: Check if the HiSpec user has write-permission in the HiSpec installation di-
rectory, e.g. c:\Program Files\Fastec Imaging\HiSpec.  Write permission in 
this directory is necessary! 
 
A: If you are using an Ethernet switch to establish the data exchange 

with the camera, it could take several seconds up to minutes, until 

the camera is detected after power on or after connecting with the 

switch.  In this case you should wait for 1 to 2 minutes before you 

click at the reconnect or the “scan net” button 
 
Q: In Live-mode and record-mode timeouts occur while “Sync In” is enabled. 
 
A: If “Sync in” is enabled and no “sync in” signal is provided, the 
camera will not record and timeouts will occur! In this case you must 

supply the “sync in” signal to avoid timeouts. 
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8 Appendix 

8.1 Technical data  

 
 

Sensor type  Monochrome / Color  

Number of pixel 1280 x 1024 
Pixel size 14 x 14 µm 
Sensitivity at 550 nm @ 
Vref = 1V (a2 = 66h) 

25 V/lux-sec 

Spectral response 400 … 1.000nm  
Trigger External Signal, 

ImageBLITZ Trigger 

Internal Dynamic 57 dB 

Power supply  10,5 ... 30 V  

Power consumption max., 
continuous recording @ 
512 x 512 resolution and 
2500 frames/sec. 
 

 
 
7.5W 
 

Thermal resistance typ. 6.25°/W 
Serial data link GigaBit Ethernet, Baud Rate 19200 

Digital video GigaBit Ethernet 

Operating temperature +5..45°C 

Shock & vibration tbd 
Dimensions       (WxHxD) 63 x 63 x 64.5 mm (c-mount) 

63 x 63 x 92.5 mm (f-mount) 

Weight ca. 280 g (without lens) 

Lens mount C-mount or F-mount 
Software "click, drag and drop" for Windows XP 

Computer requirement Min. Pentium III 650 MHz, 1024 * 768 
Pixel, 256 MB RAM, 10 GByte Hard 
disk, GigaBit Ethernet 

File format AVI or bmp 
Recording frequency  
[frames per second = fps] 

Up to 113.000 

Shutter time min. 2 µs 
Recording modes Non circular or circular with pre- and 

post trigger 
Frame buffer [GBytes] 2 

Replay frequency 20 – 50 fps @ 1280 x 1024, depending 
on the performance of the PC 
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8.1.1  

8.2 Connector assignments 

 
 
8.2.1  Power Signal Connector of HiSpec 

 
 

 

Pinning of Lemo 6-pin female connector 

 
EEG.1B.306.CLL 
www.lemo.com 

 
Pin Nr. Level Description 

1 Pwr GND 
2 =10..30V Pwr Voltage 
3 Opto In Sync 
4 Opto In Trigger 
5 Opto GND 
6 Opto out STRB/ARM 

 
 
 



8.2.1.1 Trigger/Sync input signal definition 

 
The Digital Input 4/ Trigger and the Sync Input are isolated from the rest of 
the circuitry by an opt coupler.  The pull-up resistors R33/R32 are powered by 
an internal DC/DC converter, (X3.3V).  The opto coupler will switch if the in-
put is connected to the common GND signal.  (Pin 1 on Signal I/O connector). 
 
A positive edge on the Sync input will output the next image if the positive 
“Trigger edge” is selected in the camera menu. 
 
A positive edge on the Trigger input will stop a circular recording if the posi-
tive “Trigger edge” is selected in the camera menu. 
 

 
 
The minimum diode current for an active signal is 5mA. 
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Trigger connection example 

 

 
 
8.2.1.2 Sync/Arm Output 

This pin can output a Sync signal or an arm signal, selected by a check box in 
the camera menu.  If Sync out is selected, this output will carry a Strobe that 
corresponds to the selected exposure time of the camera.  If Arm is selected, 
it will be active if the camera runs in circular recording mode. 
 

 
 
The opt couplers output will sink 13 mA with max. 0.6V output voltage.  The 
output polarity is positive when the selected signal is active.  The suppressor 
diode protects the output against reverse voltages.  It starts conducting if the 
voltage on the output pin is greater 6V. 
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8.3 Spectral response 

 
8.3.1  Monochrome & Color Sensor with Bayer Filter 
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8.4 Dimensions 

 
8.4.1 Front / Rear 

Specifications without dimension are in mm. 
 
C-mount version: 
 
 
 

8x M4 X7

4
8 6
3

C-Mount 1"
56

64.5

63
4x W 1/4" x7

 
 
 
F-mount version: 
 
 

8x M4 X7

4
8

4x W 1/4" x7

F-Mount 84

63

92.5

6
3

 
 


